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PROLOGUE

Understanding Legal MacPac is important because deadlines and unexpected events are
commonplace in the legal industry.  For instance, a time-sensitive document may be
needed ahead of schedule and you find yourself working over a weekend with no
secretarial support.  If MacPac is new to you, you may be frustrated by a document that
contains features (e.g., styles or numbering schemes) with which you are unfamiliar.  Or,
you may edit a document using manual formatting which may create future difficulties or
hinder an eleventh-hour submission.

As an attorney, your secretary will perform much of the detailed formatting of
documents.  However, you will need to understand the basics of Legal MacPac to remove
much of that formatting burden, both for you and your secretary.

INSTRUCTOR NOTE:

Specifically tell students that all the step by step instructions are in this guide, so they do
NOT have to take notes.  They can sit back and absorb.  There will be time for Q&A
and a minute or two of Q&A hands on practice at the end of critical lessons.

INSTRUCTOR NOTE:  Keep the pace snappy!  Explain to students that a lot is crammed
into this 90 minute class.  In order to cover it all, it is necessary to keep moving and make
the class primarily demonstration.

There will be specific times that hands on will take place, and those times will be
identified by the instructor.  When students attempt to perform hands on simultaneously
on their computer with the instructor, two things often happen:

• They feel like a million bucks when they walk out of the class because they did
everything that the Instructor did.  When they get back to their desk, they
typically cannot repeat what they did in class, because they did not learn.  Rather,
they followed directions.  Learning is more effective when the student can
observe an entire task or procedure and then repeat it independently.

• When a student is trying to do what the trainer is doing, their eyes travel back and
forth from their own screen to the trainer’s screen.  Inevitably, when their eyes are
on their own screen, they are missing steps that the instructor has taken or
information the instructor is providing.  This causes the trainer to have to repeat
and lengthens the training time.

Also, specifically tell students that all the step by step instructions are in this guide, so
that
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INSTRUCTOR PREPARATION:

• Add a person to your author list before class starts or you will not be able to use
templates.

• Have an electronic copy of a document # 1,836,484, version 1 made for each
student for a numbering exercise.

• When teaching a lesson for the first time, or after a long period of not teaching the
lesson, you must engage in a dress rehearsal and time your delivery so it is
consistent with the recommended delivery times.
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INTRODUCTION

Legal MacPac is a set of Morgan Lewis-specific macros and templates that work
with Microsoft Word to simplify cumbersome procedures.  For example,
paragraph numbering, page numbering, the creation of custom headers and
footers, complex formatting, the creation of a Table of Contents, etc. can be
accomplished automatically.  Legal MacPac produces polished work product with
minimal knowledge of Word while it provides a standardized “Morganized”
format for documents that can be quickly edited.

Additionally, this course sets the stage for higher level MacPac classes covering
pleadings, proof of service, subpoenas, customization for Litigation and Business
and Finance Documents, and more.
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LESSON 1
USING TEMPLATES

INSTRUCTOR NOTE:  This lesson should take approximately 8 minutes.

In this lesson, you will learn how to:

• Use Custom Templates to streamline the creation of letters, memos,
fax cover sheets, pleadings, and other legal and administrative forms.

• Use the powerful little extras of MacPac designed to simplify
appending a fax cover sheet or notary form to an existing document,
inserting an iManage document id in a document, etc.

• Set up initial author information (one time only) that can be used
repetitively.
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CUSTOM TEMPLATES

INSTRUCTOR NOTE:  Scenario:  You are in on the weekend and need to produce a
finished work product.  You don’t know how to properly format a letter.  How do you
type a letter and make sure the date prints in the proper place without obliterating the
letterhead?  How do you line up the caption for a pleading, and what information needs to
be included?  MacPac handles all of this.

� Discussion

MacPac simplifies the preparation of forms, such as letters, memos, faxes,
notary forms, messenger forms, depositions and pleadings.  When a new
document is created, you are prompted to choose an appropriate template.
Table 1 lists the available templates, grouped according to practice area.

Once a template is opened, the MacPac menu options change to reflect tasks
commonly performed with that template.  Options in the top half of the menu
are generally consistent within all templates.  However, options below the
separator line on the menu change based on the selected template.  Options
above the separator line are defined in Table 2.

INSTRUCTOR NOTE: Demonstrate (without great detail) the Business template and
then the Certificate of Service.  Show how menu options differ with each template.
Stress that MacPac is accessed in three different places:

1. File/New

2. Menus (MacPac & Symbol)

3. Numbering Toolbar

The following tables are here for reference.  You are not expected to describe each item.
Ask students to look over this page so they can see what is available.

Table 1

TEMPLATES USED BY
ALL PERSONNEL

DESCRIPTION OF TEMPLATE

Letter.dot Creates properly formatted letter designed to be printed
on engraved letterhead

Memo.dot Creates properly formatted memo including Morgan
Lewis logo

Executive Letter.dot Creates properly formatted letter for printing on
executive-size letterhead
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TEMPLATES USED BY
ALL PERSONNEL

DESCRIPTION OF TEMPLATE

Fax.dot Creates fax cover sheet with removable billing
information area

Messenger Form.dot Creates form that provides instructions for hand-delivery
and all information necessary for chargeback for the
service

Business.dot Creates any document that does not fall into the
category of any other template;  allows for insertion
and formatting of cover page, and appropriate page
numbering

Notary.dot Creates a Notary Form

TEMPLATES USED BY
LITIGATION

DESCRIPTION OF TEMPLATE

Bates Labels.dot Creates Bates Labels
Certificate of Service.dot Creates Certificate of Service
Depo Summary.dot Creates Deposition Summary
Pleading CA
Appellate.dot

Creates pleading appropriate for designated court and
state

Pleading CA.dot Creates pleading appropriate for designated court and
state

Pleading FL.dot Creates pleading appropriate for designated court and
state

Pleading NJ.dot Creates pleading appropriate for designated court and
state

Pleading PA.dot Creates pleading appropriate for designated court and
state

Proof of Service.dot Creates a Proof of Service
Subpoena.dot Creates a Subpoena
Trial Exhibit Labels.dot Creates Trial Exhibit Labels
Verification.dot Creates Verification

Table 2

Menu Option What Can This Option Do For Me?

Fax Cover Sheet Appends a fax cover sheet to the document on the screen (as
opposed to using File|New to create a fax cover sheet that is
stored as a separate document)

Notary Forms Appends a notary form to the document that is on the screen
(as opposed to using File|New to create a notary form that is
stored as a separate document)
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Menu Option What Can This Option Do For Me?

Labels Automates generation of a variety of single label or multiple
labels (labels can be created for a mass mailing using names
and addresses stored in Lotus Notes)

Envelopes Automates generation of a single envelope or multiple
envelopes (envelopes can be created for a mass mailing using
names and addresses stored in Lotus Notes)

Office Addresses Sets your home office to automatically display in letterhead,
etc., and enables the insertion (or reference) of any Morgan
Lewis office address in any document

Address Books Inserts an address that is stored in an address book in Lotus
Notes into a document

Document Font Changes the font of all text in the current document

Firm Footnote Style Inserts a footnote with the Morgan Lewis customized look

Reset Styles Resets any changes you may have made to style definitions in
the current document to those pre-defined in the current
template

Manage Author
Lists

Stores information such as the author of a document, phone
number, office address, Bar number, etc., eliminating the need
for repetitive typing

Trailer:  Insert Doc
ID

Inserts iManage document number in a footer or at the end of a
document

SETTING UP INITIAL USER INFORMATION

� Discussion

MacPac eliminates repetitive typing by storing commonly used information.
The first time you use MacPac, set up your “home” office and add yourself or
the attorney(s), paralegal(s) or administrative manager(s) for whom you work
to the system.  By selecting a “home” office, Legal MacPac pulls your office
address into your letterhead, memo, fax cover sheet, etc.  In addition,
information such as phone number, fax number, preferences for the closing of
a letter, etc. can be stored and retrieved automatically.



Legal MacPac 101

Morgan, Lewis & Bockius LLP 5 Technology Education Team

· Procedures for Setting Your “Home” Office

1. From the MacPac menu, select Office Addresses.

2. Highlight the office where you normally work and click the Set button.

¤ Note: This is a one-time process.

MANAGING AUTHOR LISTS

� Discussion

MacPac stores relevant author information in an Author List (also referred to
as your Private List).  By storing author information in your Private List, one
eliminates the need to type the author of a document, phone number, office
address, bar number, etc.  Typically, an attorney enters only their own name
and information in their Private List.  However, a secretary will likely enter
information and preferences for all of the attorneys for whom he or she works.
This information is stored on the PC where it was created, making it available
to a floating secretary.  Therefore, a floating secretary will automatically have
access to an attorney’s preferences.
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· Procedures for Managing Author Lists

1. From the MacPac menu, select Manage Author Lists.  The Private List tab
will display.

INSTRUCTOR NOTE: Point out that there is a Groups tab, but it is not fully enabled.  In
order for the Groups tab to be fully functional, a public list must be available from which
one can pull names to form groups.  Morgan Lewis does not maintain a public list.
However, “Groups” can be formed by pulling names from the Manage Author List if that
is useful.

2. Click the New Button.

3. Type the appropriate information and <Tab> to move to subsequent fields.

¤ Note:  Morgan Lewis preferred style for phone number is
222.222.2222 rather than 222-222-2222.

¤ Note:  Information stored in the Private List for attorneys SHOULD
NOT INCLUDE A TITLE.  Information stored in the Private List for
those who are not attorneys MUST HAVE A TITLE entered in the
Title field.  This information is used in the area of the letter above the
date and in the signature block.  Any letter on Morgan Lewis
letterhead being signed by a person who is not an attorney must
include that person’s title, so that the recipient of the letter is aware
the sender is not an attorney.
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¤ Note:  Attorney Bar No. must be entered in order to be able to use
MacPac Pleading templates.

4. Click the Save button  to save the information you have entered.

5. Repeat steps 2 through 4 for additional authors.

6. Click the Finish button  when all information has been added and
saved.

¤ Note:  This is a one-time process, but an important one.  Without an
author saved in the Private List, you will get an error when creating a
new document using a template.
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LESSON 2 -
DEMYSTIFYING STYLES

INSTRUCTOR NOTE:  This lesson should take approximately 8 minutes.

In this lesson, you will learn:

• Why you should care about Styles.

• How to determine if Styles are being used in a document.
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STYLES ARE RELEVANT TO EVERYONE

INSTRUCTOR NOTE:  Scenario:  When you get a new phone, you initially learn how to
store frequently called phone numbers so that you may work more efficiently in the
future.  That same initial investment of time can be compared to learning Word’s Styles
so attorneys may work more efficiently as they move forward.  Before one uses MacPac,
one needs some background information to maximize its effectiveness.

� Discussion

Why Should I Care About Styles?  Styles can be frustrating until you
understand the underlying concept. However, once you get over the learning
hurdle, they are logical and liberating.  A brief investment of time is time well
spent.

What Are Styles?  Styles are a collection of “named” formatting instructions
that can easily and quickly format text. There are two types of Styles in Word:
Paragraph Styles and Character Styles.  Morgan Lewis focuses primarily on
Paragraph Styles.  For example, a Style may contain instructions to center a
paragraph, underline text, use a specific font in a specific size, or leave a
blank line after the end of a paragraph (called spacing after).

Why Use Styles?

Efficiency

Get the job done fast.  When you use styles, multiple formatting changes can
be made with one command.

INSTRUCTOR NOTE:

The purpose of the demonstration outlined below is to show that using styles allows you
to edit a document efficiently.  The example below demonstrates that if you need to make
a formatting change to multiple headings in a document, and have used styles, you will
only need to make the change in one place to affect all of the headings.

Create a document using the Business template.  Be sure that you check the option to turn
off the title page.

Make sure that you are in Normal view.

Change the style of the first paragraph to Normal.

Type “Introduction” (in paragraph where the Style is Body Text)
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Bold, italicize, and change font to Ariel 9 pt (via direct formatting).  Point out that this
took 4 steps.

Retype “Introduction” in the paragraph with Normal Style applied and then apply the
Style called Heading 9.

Type an additional heading, “Statement of Facts” that has the Heading 9 Style applied.

Modify the Style to be centered and explain that if there were 100 headings in the
document, all 100 instances of that heading would be modified.

Document Stability

Documents created using Styles are much less likely to become corrupt.  This
is particularly critical in an environment where documents are copied over and
over again.

INSTRUCTOR NOTE:

Explain how direct formatting negatively affects the stability of a document.  Give the
following example:

If you directly format a heading with bold, center and underline, 3 codes are added to
your document (one for each format change).  If you have 100 such headings in your
document, you add 300 codes to your document.  The more codes you have in your
document, the more system overhead is needed to edit, print and render the document on
the screen, and the more likely the document is to become corrupt.  When you create a
Style that bolds, centers and underlines, the codes for those Styles are stored in one place,
the Style definition.  Therefore, regardless of the number of headings contained in a
document, you will add only the 3 commands that are stored in the Style definition.  The
use of Styles instead of direct formatting dramatically reduces system overhead and
increases the stability of a document.

INSTRUCTOR NOTE:

Scenario:  An attorney has a lease that he or she suspects is “bad”, but only needs one
minor edit to finalize it for a client.  The attorney breathes a sigh of relief when the hard
copy is printed.  One month later, when a young associate is creating a lease for a client,
she copies the questionable document as the basis for her new lease.  At the eleventh hour
the document freezes each time it is opened, and can no longer be edited.

• The attorney who first noticed that the document was crashing could have helped
his or her colleagues by deleting it, or at the very least, indicated in the iManage
Description field that the document was corrupt.
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• When copying a document of unknown origin, paste special should be used in
order to leave behind unwanted codes and corruption. Any document that you did
not personally type from scratch on the system should be considered of unknown
origin.

• The attorney who attempted to copy the document could have avoided disruptions
in work by using DocXTools, Am I a Bad Document since the document was of
unknown origin and it is not clear whether or not paste special was used  You will
learn more about paste special and DocXTools in DocXTools and Corrupt Files
101.

Consistency

Styles assure that all like headings within a document are formatted
consistently for a more professional look, making the document easier to edit
and read.

INSTRUCTOR NOTE:

Let students know that this is not intended to be a lesson on how to use Styles.  It is just
intended to give them background information.  Also, let them know that MacPac
templates use Styles and that Styles are the basis for the paragraph numbering that is used
by MacPac.  Be sure to work in Normal View while demonstrating the templates so
students can see examples of Styles used.

INSTRUCTOR NOTE:

Give a brief explanation of the two views that are most commonly used and advantages
of each of these views:

Page Layout View –Views a document as it will appear when printed.  Items such as
headers, footers, footnotes and graphic images appear as they will in the document.

Normal View - Beneficial for typing, editing, and formatting text.  When in Normal
view, there is a Style area that can be activated so that the style associated with each
paragraph is displayed to the left of the paragraph.  Normal view shows text formatting
but simplifies the layout of the page so that you can type and edit quickly.  Graphics do
not display in Normal view.
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· Procedures for Determining if Styles are Being Used

1. From the View menu, choose Normal.

INSTRUCTOR NOTE:

Depending on your audience, you may want to show students that Views in Word can
also be changed by clicking on one of the View buttons in the bottom left part of the
application window.
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2. In Normal View, you will see the Style (on the left side of the screen)
associated with the paragraph next to it.  This area of the screen is called the
Style Area.  Below is a sample of the Styles that are used in the letter template.



Legal MacPac 101

Morgan, Lewis & Bockius LLP 14 Technology Education Team

¤ Note:  If you are using the Normal View, and you still do not see a
styles area, take the following steps:

§ From the Tools menu, choose Options .

§ Click the View tab.

§ In the Style area width field, increase the width to approximately
.5” and click OK.
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¤ Note:  There is a style called the Normal Style.  Normal is listed when
no style is used.  If the Style area of the screen looks like the example
below, then Styles were not used in the document.
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LESSON 3 -
WORKING EFFICIENTLY WITH LETTERS

INSTRUCTOR NOTE:  This lesson should take approximately 20 to 25 minutes
depending upon whether or not exercise is done.

In this lesson, you will learn how to:

• Format documents easily without the help of an experienced secretary.

• Customize the closing of a letter and other preferences for use in all
letters.

• Insert an iManage document number into a document.

• Quickly insert commonly used symbols.

• Edit a letter without losing important formatting.
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WORKING EFFICIENTLY W ITH LETTERS

� Discussion

Using the Legal MacPac letter template speeds up mundane tasks by giving
you the tools to:

§ Establish your personal preferences for closings, include or exclude e-mail
address, fax number, etc. in letterhead, and change paragraph formats.

§ Establish preferences for printing on engraved letterhead (Morgan Lewis
standard) or Word-generated letterhead (used when faxing or e-mailing a
letter).

§ Place the recipient name in the header of the letter on the second and
subsequent pages.

§ Pull names and addresses from your Address Book in Lotus Notes.

§ Insert Delivery and Confidentiality phrases from a list (rather than typing).

· Procedures for Automatic Formatting of Recipient
Information

1. Click the New button  on the standard toolbar in Word.

2. From the General tab, double-click Letter.dot.
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¤ Note:  When you access the Create a Letter dialog box, the screen
contains three tabs:  Main, Closing and Options.

3. Complete the information in Main tab concerning Recipients,
Delivery/Confidential Phrases, Salutation, and Re: Line.

4. You may either type the name and address of the recipient or click the Address
Books button to pull names and addresses that are stored in your Lotus Notes
contact list.

INSTRUCTOR NOTE:

Demonstrate pulling a name from Lotus Notes in order to encourage students to use
Lotus Notes Personal Address Book.  The personal address book is being used rather than
the Firm address book because one does not generally send letters internally to Morgan
Lewis people.

¤ Note:  With the assistance of the IS Department, an attorney can share
a Lotus Notes Personal Address Book with his or her secretary.  Once
sharing has been set up, a secretary sees all Address Books to which
he or she has access when clicking the Address Books button.
Consequently, the secretary can pull addresses either from her own or
the attorney’s address book.  Contact the Help Desk for assistance
with sharing Personal Address Books.
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5. To insert Delivery/Confidential Phrases, double-click the desired phrase to
move it to Current Selections.  These phrases appear only on the first page
unless you select the Include Phrases in Header option.

¤ Note:  To delete a Delivery/Confidential Phrase in the Current
Selections section, click the Clear button.

6. Information in the Client/Matter No. field will be inserted on the last line of the
Re: Line.

7. In the Re: Line field, enter the subject line of the letter.  Text will automatically
wrap to accommodate a lengthy entry.  There is no limit to the length of the
subject line.  You may force a line break by pressing <Enter>.
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· Procedures for Completing the Closing of Your Letter

1. Click the Closing tab.

2. The information that displays in this dialog box is being pulled from the Private
List.  Use the pull-down menu next to the Author field to select an alternate
author that has been saved to the Private List.

¤ Note:  If you wish to add a new author to your Private List, click on

the Manage Lists button  (see Procedures for Managing
Author Lists in Lesson 1).

¤ Note:  Once you have chosen an Author, click the Set button  to
select the current author as the author that will display when you
create each new letter.
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3. Information in the Author Detail area is pulled from the Private List.  If
information is typed directly into the Author Detail section, it is critical that
attorneys DO NOT ENTER A TITLE.  Non-attorney signers MUST
INCLUDE A TITLE so that the recipient of the letter is aware that the sender
is not an attorney.

¤ Note:  The Restrictions field is intended for an attorney to designate
that he or she is admitted to a bar in a state or states in addition to the
state in which they are currently practicing.  When this field is
populated and the letter is generated, an asterisk will appear next to
the attorney's name.  A second asterisk with the actual restriction text
appears beneath the e-mail address.

Example:

Jonathan M. Smith*
877.246.8102
jsmith@morganlewis.com
*Admitted in New York

4. Complete the Enclosures, Initials, c: and bc: fields as appropriate.
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· Procedures for Setting Personal Preferences for a
Letter

1. Click the Options tab.

¤ Note:  In most cases, no changes will be necessary to the author’s
personal preferences displayed.  However, you might need to change
from engraved letterhead  (Engraved – NEW) to Word-generated
letterhead (Word-Generated – NEW) if the letter is going to be sent
via e-mail or fax.  This capability may be critical to an attorney who is
working on the weekend, without a secretary’s assistance.

¤ Note:  Personal preferences can be changed for a one-time letter or on
a permanent basis.  If you wish to change settings for all letters
created in the future for a particular author, you may do so by making

the changes and clicking the Save button  on the Options tab.

¤ Note:  Signature Type determines whether or not the Title indicated in
the Private List appears after the author’s name in the letter.
Information stored in the Private List for attorneys SHOULD NOT
INCLUDE A TITLE.  Non-attorney signers MUST INCLUDE A
TITLE so that the recipient of the letter is aware that the sender is not
an attorney.
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¤ Note:  The Reset button allows you to reset personal options back to
the firm defaults as shown below:

2. Click Finish and begin typing your letter.

INSTRUCTOR NOTE:

At this point the attorneys may be looking at their watches thinking that this took too
long.  Take a minute to explain that in real life creating a letter will be done in a snap
because preferences will be set.  Demo and stress how quick it is.  When you demo, pull
name and address from Lotus Notes.  Here are the points to make in the demo:

• It is a quick process.

• Show where Styles are used.

Save this letter now so that you can demo insert doc id and use for demo of editing a
letter.

INSERTING DOC ID

� Discussion

It is useful to place the iManage document number in a document so that it
can be easily found in our Document Management system.  As you save a
document, a reminder dialog box will pop up, asking where to place the
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number.  The iManage number can appear in a footer, at the end of the
document, or one may opt to remove the document ID.  The document ID is
referred to as a trailer.

· Procedures for Inserting Doc ID

1. From the MacPac menu, select Trailer: Insert Doc ID.

2. In the Trailer Type section, choose the option that best suits your needs.

3. In the Include section, select additional items (such as Draft, Date, and/or Time)
to be included in the trailer.  Once selected, these options apply to new
documents until deselected.

~ CAUTION:  When a document is copied or a new version of a
document is made, the trailer needs to be updated.  It is highly
recommended that you select Trailer:  Insert Doc ID to update the
trailer even if you previously inserted the trailer with the option to
Turn on ‘auto’ trailer.

INSTRUCTOR NOTE:

Take a minute to put a page break into the document on screen and then preview the
document so students can see the footer and header.

QUICKLY INSERTING COMMONLY USED SYMBOLS

� Discussion

The Symbol menu provides quick access to commonly used symbols such as
the section mark, the paragraph mark, copyright, etc.
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· Procedures for Inserting Commonly Used Symbols

1. Place the cursor in your document where the symbol is to be inserted.

2. From the main menu in Word, select Symbol.

3. From the Symbol menu, select the desired symbol.

¤ Note:  <Alt>+<Y> is the keystroke to access the Symbol menu.  Once
the menu is accessed, press the underlined letter of the symbol to
access that symbol.  For example, to access the Trademark ™ symbol,
press <Alt>+<Y>, release, and press <T>.

MACROS AVAILABLE FOR FASTER EDITING

� Discussion

There are four macros available for faster editing of letters:
Delivery/Confidential Phrases, Letterhead, Letter Signature , and Reuse.
The macros use advanced Word features such as headers and paragraph
formatting (without the individual needing knowledge of these features) and
prevent existing formatting from being accidentally overwritten.
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INSTRUCTOR NOTE:

Use the letter on the screen to demo the incorrect way of editing a letter.  Open an
existing letter (that has a Delivery/Confidential Phrase).  Manually delete the phrase
(including the paragraph mark).  When you type in a new phrase, it will not be bolded or
in all caps.  Then, demo using MacPac menu options to edit Delivery/Confidential
Phrase.  Stress that use of the MacPac menu options eliminates the possibility of
typographical errors and performs necessary formatting for you.

· Procedures for Editing Delivery/Confidential Phrases

1. Open the letter to be edited.  To use the editing macros, Legal MacPac’s letter
template must have been used to create the letter.

¤ Note: You will know that Legal MacPac’s letter template was used to
create the document if you access the MacPac menu and see the
following options below the separator line:

INSTRUCTOR NOTE:

Point out that if the student comes across a letter that was created without using MacPac,
the body of that letter can be copied into a legitimate MacPac letter template.  This seems
like a lot of work, but will be well worth it if the letter will continue to be reused.
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2. Select Delivery/Confidential Phrases from the MacPac menu to make
changes to the Delivery statement or Confidentiality phrase.

¤ Note:  Items on the MacPac menu appearing below the separator line
will vary depending upon the template open at the time.

3. From the Insert Delivery/Confidential Phrases dialog box, click Clear to
remove any unwanted phrases in the Current Selections field.

4. Highlight each phrase that you wish to add and click Add.
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¤ Note:  To place the Delivery/Confidential Phrases in a header, check
the Include Phrases in Header box.  Then, to indicate whether the
phrase(s) should be placed in the header for only the Current Section
or in the Entire Document select the desired option in the Scope
section of the dialog box.

5. When all Delivery/Confidential Phrases have been selected, click Finish.

INSTRUCTOR NOTE:

Point out to attorneys that if they need to come in on a weekend and get a letter out the
door, this next lesson could be critical.  For example, if the secretary generates a letter on
engraved letterhead, and the attorney needs to send it out via e-mail on the weekend, the
attorney needs to be familiar with the Letterhead option from the MacPac menu.
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· Procedures for Changing Information in the
Letterhead Banner

1. From the MacPac menu, select Letterhead to make changes under the Main
tab or the Options tab.
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2. When all changes have been made, click Finish.

¤ Note:  It is important to understand that changes made using the
Letterhead command from the MacPac menu will only affect
information in the letterhead banner at the top of the letter (see
diagram below for a clear understanding of what is meant by
letterhead banner).

For example, if an author is changed, by using the Letterhead
command from the MacPac menu, the author will only be changed in
the letterhead banner at the top of the page.  The signature block of the
letter will remain unchanged.  To change the signature block of the
letter, you must use the Letter Signature  command from the MacPac
menu (see next lesson).

Scott Newman
Training Manager
215.963.5847
snewman@morganlewis.com

March 6, 2003

VIA FEDERAL EXPRESS

John Doe
123 Main Street
Philadelphia, PA  19103

Re: New Hire Training
Client/Matter No. 123456-0000

Dear John:

We are pleased to learn that you will be joining us for New Hire Training
on June 1, 2003.  Please come to the reception area at 9:00 and ask for Mary Trainer.

Sincerely,

Scott Newman
Training Manager

Letterhead
banner

Signature
Block
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· Procedures for Making Edits to the Signature Block of
a Letter

1. In the letter, select the entire signature block that needs to be edited.

2. From the MacPac menu, choose Letter Signature .

3. Make the appropriate changes, then click the Finish button.

¤ Note:  When the information in the Letter Signature Block is changed,
a new closing and author will be inserted in the letter at the point of
the cursor.  If you do not first select or delete the original signature
block, you will have two signature blocks in your letter.

REUSING A LETTER

INSTRUCTOR NOTE:

Scenario:  You have a letter on the system to John Doe.  You now need to send John Doe
another letter with a different Re: line.
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Open an existing letter.  First, demo manually changing a Re: line that has a client
number just below.  When you make the change, delete the original Re: line and the
manual line break.  Type in the new Re: line and press <Enter> to type the client/matter
number on the next line.  Re: line will no longer be formatted as it used to be.  Next,
demo using the Reuse function.

� Discussion

Letters created with MacPac templates can be used to duplicate standard
information.  The Reuse function takes basic information from one letter (e.g.,
Re: line, recipient information, signature block, but not the text of the letter)
and reuses it in a new letter in order to save time.  When the old letter is
reused, the newly created letter either replaces the existing letter or appends a
new letter at the end of the existing letter (not a desirable option).  Therefore,
it is recommended that the letter be copied via iManage before Reusing.

· Procedures for Reusing a Letter

1. Locate the letter to be used as a “boilerplate" in iManage and highlight it.

2. Right-click and choose Copy and then Copy Document and Open.

~ CAUTION:

REUSING A LETTER REPLACES THE EXISTING LETTER.
Before you use the Reuse menu option, be sure to make a copy of the
letter to reuse (unless you no longer need a copy of the original
letter).

3. From the MacPac menu, choose Reuse.
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4. Select Replace the Existing Letter Document (if it is not already selected) and
click OK.

5. From the Create a Letter dialog box, make the desired changes and click
Finish.

INSTRUCTOR NOTE:

Save the letter so that the students can see the new trailer dialog box.

INSTRUCTOR NOTE:

Suggest that students practice creating a simple letter.  If they prefer a formal exercise,
one is provided.  This is not a break, so students should not leave the room.  You will
begin again on time.  Tell students to take a minute to explore the items just taught and
ask questions.
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HANDS ON Q & A #1

INSTRUCTOR NOTE:

Exercise 1 is intended for secretaries.  Exercise 2 is intended for attorneys.

Creating and Editing a Letter

� Task

1. Create the following letter to be printed on engraved letterhead and save it.

Scott Newman
Training Manager
215.963.5847
snewman@morganlewis.com

March 6, 2003

VIA FEDERAL EXPRESS

John Doe
123 Main Street
Philadelphia, PA  19103

Re: New Hire Training
Client/Matter No. 123456-0000

Dear John:

We are pleased to learn that you will be joining us for New Hire Training on June 1, 2003.  Please
come to the reception area at 9:00 and ask for Mary Trainer.

We look forward to working with you.  If you have any questions, feel free to contact me at
215.963.5847.

Sincerely,

Scott Newman
Training Manager
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2. You will be preparing many letters for Scott Newman, so add him to your
Private List.

3. Make changes so that the letter can be sent via fax.  These changes will include
changing the Delivery Phrase in the letter and changing the letterhead so that
the firm logo will appear when faxed.

4. John Green will be taking over some of  Scott Newman’s responsibilities while
Scott works on a special project.  The letter should no longer be signed by Scott
Newman.  It should be signed by John Green.  You will be preparing a lot of
letters for John, so add him to your Private List as well.

Here is John’s information:

Office:  Philadelphia
Bar No.:  123456
Initials:  JJG
Phone:  215.963.5847
Fax:  215.963.4444
Title:  Training Specialist
E-Mail:  jgreen@morganlewis.com
Employee Number:  MP011222
Floor:  8

5. John prefers to sign his letters, “Respectfully,”.

6. John prefers that his e-mail address not appear on letters.
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Your letter should look like this:

John J. Green
Training Specialist
jgreen@morganlewis.com

April 25, 2003

VIA FACSIMILE

John Doe
123 Main Street
Philadelphia, PA  19103

Re: New Hire Training
Client/Matter No. 123456-0000

Dear John:

We are pleased to learn that you will be joining us for New Hire Training on June 1, 2003.  Please
come to the reception area at 9:00 and ask for Mary Trainer.

We look forward to working with you.  If you have any questions, feel free to contact me at
215.963.5847.

Respectfully,

John J. Green
Training Specialist
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HANDS ON Q & A #2
INSTRUCTOR NOTE:

Exercise 2 is intended for attorneys.

Creating and Editing a Letter

� Task

1. Create the following letter to be printed on engraved letterhead and save it.

2. Make changes so that the letter can be sent via fax.  These changes will include
changing the Delivery Phrase in the letter and changing the letterhead so that
the firm logo will appear when faxed.
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LESSON 4 -
“MORGANIZING” MEMOS

INSTRUCTOR NOTE:  This lesson should take approximately 5 to 6 minutes depending
upon whether or not exercise is done.

In this lesson, you will learn how to:

• Create a Morganized memo with the push of a button.

• Set preferences to eliminate repetitive tasks.

• Reuse a memo.
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CREATING A MEMO THAT LOOKS PROFESSIONAL
AND TAKES MINIMAL TIME

� Discussion

Producing MacPac memos is fast and efficient.  Without MacPac, production
of a memo is often a multi-step process.  First, the attorney drafts the memo.
Then, the secretary adds all necessary formatting.  Because more attorneys are
choosing to draft their own memos and documents, MacPac benefits everyone
by eliminating steps.

· Procedures for Creating a New Memo

1. Click the New button  on the standard toolbar in Word and double-click
Memo.dot.

2. The Create a Memo dialog box opens.
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3. Complete the People section of the dialog box by typing in the names of the
recipients in the To, From, c, and bc fields.  Alternately, if the names of the
recipients or sender exist in your MacPac Private List, they may be inserted by
clicking on the To, From, c, and bc…buttons and selecting the desired name.

4. Select the appropriate Delivery/Confidential Phrases (see Procedures for
Automatic Formatting of Recipient Information in Lesson 3).

¤ Note:  The Use Firm Options  button sets all of the options back to the
firm defaults.

¤ Note:  To set the From field to always select a specified person:

§ From the Create a Memo dialog box, click the From button.  The
Recipients dialog box displays.

§ Select the desired name from the Private List on the left side of the
screen and click the From button.  You will need to delete any
unwanted names from the From field.

§ Click Set to enable the From field to automatically be filled with
? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ame and click OK to close the
window.

5. Complete remaining fields as desired in the Create a Memo dialog box and
click Finish to begin typing the memo.
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INSTRUCTOR NOTE:

Place some text in the memo followed by a hard page break.  Preview the memo to show
students the masthead, page numbering, etc.  Save memo in case it is necessary to
demonstrate reusing memo.

REUSING A MEMO

� Discussion

Memos are edited and reused through the MacPac menu in the same manner
as letters (see Lesson 3).  It is important to remember that the Reuse option
overwrites the original memo.  To avoid overwriting a memo, choose copy
and open from iManage.

INSTRUCTOR NOTE:

Offer students time to create a blank memo or Q&A if desired.  Keep this hands on time
to approximately 1 minute to keep things moving.
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LESSON 5 -
FACILITATING FAXES

INSTRUCTOR NOTE:  This lesson should take approximately 5 to 7 minutes depending
upon whether exercise is done.

In this lesson, you will learn how to:

• Create a fax cover sheet

• Reuse a fax cover sheet
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CREATING A FAX COVER SHEET

� Discussion

You can eliminate the time spent manually completing preprinted fax cover
sheets by keeping valuable information stored on your computer.  MacPac
automates the process of creating a fax cover sheet by saving repetitive
information such as one or more names and addresses, and the phone numbers
of the sender.  When you address a fax to multiple recipients, a separate cover
sheet can be automatically created for each recipient.  The MacPac fax cover
sheet is a substitute for preprinted fax cover sheets.

· Procedures for Creating a Fax Cover Sheet

1. Click the New button  on the standard toolbar in Word and double click the
Fax.dot icon.
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2. The Create a Fax Cover Sheet dialog box opens.

3. To add recipient(s), click the Address button to pull name(s) and phone
numbers from a Lotus Notes Address Book.   If a recipient’s name is not stored
in a Lotus Notes Address Book, type the recipient information in the To section
and click Add to add each recipient to the Recipients field on the right side of
the screen.

4. If you added multiple recipients, the option Separate Cover Page for Each
becomes available.  Select the box next to the option, if appropriate.

5. Complete the Author Message and Options tab and click Finish.

¤ Note:  There is a tear-off portion of the cover sheet that is used for
billing purposes.  Be sure to detach before faxing.

KEEP THE FAX COVER SHEET TEMPLATE OPEN.
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REUSING A FAX COVER SHEET

� Discussion

Fax cover sheets are reused through the MacPac menu in the same manner as
letters and memos (see Lesson 3).  It is important to remember that the Reuse
option overwrites the original fax cover sheet.

INSTRUCTOR NOTE:

Offer students opportunity to create a fax coversheet and give time for Q&A.  Try to limit
to 2 minutes.
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LESSON 6 -
PARAGRAPH NUMBERING

INSTRUCTOR NOTE:  This lesson should take approximately 20 to 23 minutes
depending upon whether exercise is done.  Conduct the lesson as a demo and provide
hands on practice at the end.

In this lesson, you will learn how to:

• Select a numbering scheme.

• Insert automatic numbering.

• Stop numbering.

• Promote/demote numbering.

• Restart numbering.

• Continue numbering.
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SELECTING A NUMBERING SCHEME

INSTRUCTOR NOTE:

It is critical that automatic paragraph numbering be used.

Scenario:  If automatic paragraph numbering is not used, and a decision is made to delete
the second out of 100 paragraphs, the last 98 paragraphs will need to be renumbered
manually.

� Discussion

MacPac numbering is used throughout the firm.  Although the end result may
look similar to Word’s numbering feature, what goes on behind the scenes is
different.  It is important that you do not mix Word numbering and MacPac
numbering in the same document.  To prevent confusion, it is best to avoid
Word numbering completely.

Knowing which numbering schemes are most relevant to your practice area is
important.  MacPac provides 11 numbering schemes (numbering styles),
which determine how numbers look (e.g., Roman, Arabic, capital letter, etc.)
at each outline level (e.g., level 1, level 2, etc.).  Selecting a numbering
scheme is analogous to selecting a different ring for your phone.  When you
select a ring, there is no apparent change until someone calls you.  When you
select a numbering scheme, nothing will happen until you give the command
to insert automatic numbering.

INSTRUCTOR NOTE:

Show students that everything they will need to use automatic paragraph numbering is
found on the numbering toolbar.  Show students which part of the toolbar they will use.
Explain that numbering is a two part process:

1.  Selecting the scheme.

2.  Inserting the numbers.
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· Procedures for Selecting a Numbering Scheme

1. From the numbering toolbar, click Schemes.

2. The Numbering Schemes dialog box opens.  Highlight a scheme on the left side
of the dialog box to preview that scheme on the right side of the screen.

¤ Note:  At first glance, it appears there are duplicate listings of each
scheme.  The second listing has (E) next to it, which indicates an
indented European style.  This does not limit its use to European
offices.  You can use any style on the list.

3. Select the scheme and click the Use button.

¤ Note:  After you select your scheme, there is no visible sign that a
scheme has been selected.  Placing the numbered paragraphs in the
document is a separate step.
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INSERTING AUTOMATIC NUMBERING

� Discussion

Once your numbering scheme is selected, then you determine the level of
numbering with the click of a button.  The insertion of automatic numbering
can be done either as a document is typed or after the fact.

When you edit a document that was formatted by your secretary, it is not
necessary to have in-depth knowledge of Word to add numbered paragraphs.
Simply follow the directions below:

INSTRUCTOR NOTE:

There are two different scenarios in which a student might need to insert automatic
paragraph numbering:

1 Typing a document from scratch

2. Inserting numbers after completion of typing (where paragraphs either have no
numbering or manual numbering)

When going through the procedures for numbering, demonstrate both of the above
scenarios.

· Procedures for Inserting Automatic Numbering

1. Place the cursor at the position where the number is to be inserted and click the
appropriate level on the Numbering Toolbar.

2. Continue the procedure throughout the document until all numbering is
complete.  This procedure is best done as you type, but can also be done
afterward.

¤ Note:  Shortcut keys for inserting numbers are <Alt> + the level
number.
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¤ Note:  If you are adding automatic paragraph numbering to a
document that has manual numbering (or no numbering), you may
automatically number multiple contiguous paragraphs by first
selecting the paragraphs, and then clicking the appropriate numbering
level on the numbering toolbar.

¤ Note:  Once a paragraph is numbered, to change the level of
numbering, you must use the Promote or Demote button (see
procedures below).  If you click a different level of numbering in a
numbered paragraph, you will get a listnum field code.  This code can
be deleted with the <Delete> key.

PROMOTING/DEMOTING NUMBERING

� Discussion

After a number is inserted, use the Promote or Demote button to increase or
decrease the indent and the change the number style to the number style
associated with the new level.  Promoting moves to the left.  Demoting moves
to the right.

For example:

If Level 2 is Promoted , it
becomes Level 1 (i.e., the
“A.” becomes “I.”).  If it is

Demoted   , it becomes
Level 3 (i.e., the “A.”
becomes “1.”).
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· Procedures for Promoting/Demoting Numbering

1. Place the insertion point in the paragraph where the numbering is to be changed

and click either Promote Level  or Demote Level  on the numbering
toolbar.

¤ Note: Keystrokes for Promoting and Demoting a Level:

Promote Level   (<Alt>+<Shift>+ <Left Arrow>)

Demote Level   (<Alt>+<Shift>+ <Right Arrow>)

INSTRUCTOR NOTE:

For many people the MacPac terms Promote and Demote are confusing, and work
contrary to logic.  It may be beneficial to forget the terminology and focus on the visual

prompts (   and  ) in this case.

STOPPING NUMBERING

� Discussion

In most schemes, when you insert a number in the current paragraph and press
<Enter> to type the next paragraph, a paragraph number of the same level is
automatically inserted.  For example, if you insert  “I.  Introduction” and press
<Enter>, “II.” is automatically inserted.  Sometimes this is desirable, and
sometimes it is not.  If you do not want a numbered paragraph at that spot, one
simple click will eliminate the number.
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· Procedures for Stopping Numbering

1. Place the insertion point anywhere in the paragraph where the numbering is to
be removed and click the Remove Number button on the numbering toolbar.

¤ Note:  <Alt>+<Shift>+<N>,<R> is the keystroke to Stop Numbering.

¤ Note: Stop Numbering does not remove manual numbering.

RESTARTING NUMBERING

� Discussion

Occasionally, there is a need to restart numbering in the middle of a numbered
list.  For example, a document may contain a numbered list, listing five items,
followed by a paragraph with text.  Following the text is another list that
needs to start with the number one.  To start the numbering at one, the Restart
Numbering function is used.

· Procedures for Restarting Numbering

1. Place the insertion point in the paragraph where the numbering needs to be
restarted and click the Restart Numbering at 1 button on the numbering
toolbar.

INSTRUCTOR NOTE:

Stress that in order to restart numbering, numbering must first be applied.  You cannot
restart numbering if numbering does not exist.
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CONTINUING NUMBERING

� Discussion

Continue numbering is nothing more than an “undo” for Restart Numbering.
If you mistakenly decide to Restart Numbering, Continue Numbering sets the
paragraph number back to its previous state.

· Procedures for Continuing Numbering

1. Place the insertion point in the paragraph where the numbering needs to be
continued and click the Continue Numbering  from Previous Paragraph
button on the numbering toolbar.

¤ Note:  The Undo function in Word should not be used to undo a
“mistake” in MacPac.  Although you may perform a single click in
MacPac, it may translate to 15 clicks in Word due to behind-the-
scenes programming.

RECOGNIZING MACPAC’S AUTOMATIC NUMBERING

INSTRUCTOR NOTE:

Scenario:  A document needs one simple addition before being signed at a closing.  When
the secretary adds a numbered paragraph, it becomes apparent that some of the
numbering is done automatically and some manually.  Now the numbers below the
addition need to be changed.  Because of the inconsistencies in formatting, the secretary
checks the numbering and finds several other numbering errors that need to be fixed.  All
of this could have been avoided had MacPac automatic numbering been used
consistently.

� Discussion

Consistent document formatting is critical.  When a team produces a
document that needs last minute changes, consistent formatting allows the
editor(s) of the document to work quickly and efficiently.  On the other hand,
a document with numbering done manually in parts and automatically in other
parts wreaks havoc on the editor.  When editing a document, you must
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determine if the document creator used MacPac for automatic numbering.
This is accomplished easily if you are working in the Normal view as
discussed earlier.

· Procedures for Determining Whether MacPac
Numbering Is Turned on

1. From the View menu, choose Normal to view the document in the Normal
view.

2. Look in the Style area of the screen to see what Styles are in use.

Note the Style associated with the numbered paragraph.  If the Style name matches
that of a MacPac numbering scheme and ends with _L# (where # represents the
level of numbering used), then a numbering scheme is in use.
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¤ Note:  If you are in the Normal view and cannot see the Style names
to the left of the document text, your Style area is not turned on.  To
make the Style area display, see the section entitled Procedures for
Determining if Styles are Being Used in Lesson 2.

¤ Note:  It is recommended that you quickly review the entire
document's style area for consistency.   If automatic numbering was
not used, if automatic numbering was used in some places but not
others, or if different methods of automatic numbering were used in
different parts of the document, it is recommended that the manually
numbered paragraphs be changed to automatic numbering.
Consistency is important.
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HANDS ON Q & A
INSTRUCTOR NOTE:

Allow students to do the following exercise:  Have them open an electronic copy of
document #1,836,484 version 1.  The document that they open has no numbering.  Their
assignment is to choose an appropriate scheme and apply numbering.  A sample of an
appropriate numbering scheme is provided for students below.  However, if students
prefer, they can practice on their own instead of doing the formal exercise.

This exercise is designed to use a simple, generic numbering scheme to avoid a lot of
issues about editing schemes that will be covered in a higher level MacPac class.

� Exercise

1. From iManage, open document #1,836,484.1 or the document your instructor has
provided for you.

2. Using the Public Scheme called “Outline,” format the document to look like the
example below.

I. OFFICERS

A. Background.

The Corporation shall have a president, one or more vice presidents, a secretary, a
treasurer, and such other officers as shall be elected from time to time by the directors.
Any person may hold two or more offices.

B. Duties of Officers.

The duties and powers of the officers of the Corporation shall be as follows:

1. President.  The president shall be the chief executive officer of the
Corporation and shall be responsible for the active and ongoing conduct of the business
and affairs of the Corporation.

2. Vice President.  The vice president, or if there shall be more than
one (1), the vice presidents in the order so determined by the Board of Directors, shall, in
the absence or disability of the president, perform the duties and exercise the powers of
the president, and shall perform such other duties and have such other powers as the
Board of Directors may from time to time prescribe.

3. Secretary.  The secretary shall have custody of and maintain the
corporate seal and all of the corporate records except the financial records, shall record



Legal MacPac 101

Morgan, Lewis & Bockius LLP 57 Technology Education Team

the minutes of all meetings of directors, and shall perform such other duties as may be
prescribed by the Board of Directors or the president.

1-PH/1836465.1
DRAFT
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LESSON 7 -
MISCELLANEOUS TIDBITS TO KNOW
(Preview Of Higher Level Macpac Class)

INSTRUCTOR NOTE:  This lesson should take approximately 5 minutes.

In this lesson, we will briefly discuss that:

• Existing schemes can be edited.

• Customized schemes can be created and shared.

• If MacPac numbering is used, a table of contents can be generated
automatically.

• There are some issues with sharing numbered documents externally.

• Morgan Lewis has a special setup for footnotes that has limitations
when sharing documents externally.

• There are practice specific templates available.

INSTRUCTOR NOTE:

Let the students know that what you are about to go over now is intended to make the
students aware of further capabilities of MacPac.  These features will be covered in detail
in a higher level MacPac class.
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CREATING/EDITING EXISTING NUMBERING SCHEMES

� Discussion

If you don’t see the numbering scheme you need, you can edit one to fit your
needs.  When editing a scheme, you can change the numbering style at any
given level, change fonts, change paragraph formatting, etc.  Once a custom
scheme is saved, it appears on your list of available numbering schemes.

CUSTOMIZED NUMBERING SCHEMES CAN BE
SHARED

� Discussion

Once a customized numbering scheme is created, it can be shared.  For example, a
secretary may create a customized numbering scheme that can be made available to his or
her attorney.

INSTRUCTOR NOTE:

FYI. . . Shared schemes are not found as a file on the network..  There are multiple steps
necessary to share a scheme and those steps are outlined in MacPac 102.

MACPAC CAN CREATE A TABLE OF CONTENTS
WITH TWO CLICKS

� Discussion

A major benefit of using MacPac paragraph numbering is that a Table of
Contents can be produced with as few as two clicks.  Creating a Table of
Contents can be extremely time-consuming if done manually.  If a document
is going to be edited outside of Morgan Lewis, be aware that a Table of
Contents generated using MacPac will only be able to be updated using
MacPac.  However, a MacPac Table of Contents can be quickly converted to
the native Word TOC format.
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INSTRUCTOR NOTE:

Demo creating a TOC so students can see how quick it is.  Simply type a couple of lines
of text.  For example:

Introduction

This is the introduction text

Statement of Facts

This is the statement of facts text

Choose a scheme, and apply automatic paragraph numbering to the headings

(Introduction and Statement of Facts).  Click the TOC button  and show how only
the headings are included in the TOC.

ISSUES W ITH SHARING DOCUMENTS EXTERNALLY

� Discussion

Documents created using MacPac numbering can be shared with others who
do not have MacPac.  MacPac uses Styles to produce numbered paragraphs,
and Styles travel with a document.

MORGAN LEWIS’ CUSTOMIZED FOOTNOTES

� Discussion

Morgan Lewis has designed a customized look for footnotes that is available
through the MacPac menu.  When using customized footnotes, you need to be
aware there are some limitations for non-MacPac users.  For example, you
produce a document with custom footnotes and the document is sent to
someone outside of Morgan Lewis who does not have MacPac.  That person
may add footnotes, but they will not have the same look as the custom
footnotes created using MacPac.  Therefore, the recommendation is that if it is
anticipated that a document with footnotes will be going back and forth
between Morgan Lewis and an external source and footnotes may need to be
added, the MacPac menu option for Firm Footnote Style should not be used.
Instead, from the Insert menu, choose Footnote to insert the standard Word
footnote.
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¤ Note:  When faced with a document that has a mixture of
“Morganized” footnotes and standard Word footnotes, take the
following steps:

§ Determine which “style” (Morgan or non-Morgan) of footnote you
would like used throughout the document.

§ Cut or copy the text of the first “bad” footnote.

§ Insert a new blank footnote in the desired “style” (Morgan or non-
Morgan) for each footnote that needs to be replaced.

§ Paste the text into the newly created footnote.

§ Delete the original footnote.

§ Repeat these steps for each footnote that needs to be replaced.

USING PRACTICE SPECIFIC TEMPLATES

� Discussion

Firm templates are available to you each time you choose to create a new
document.  Use of the firm templates eases the tedious task of document
formatting.  Each template works a little differently, but all are self-
explanatory for the most part.

INSTRUCTOR NOTE:

If you only have a litigation attorney or secretary in class, now is the time to have them
explore or you demo some of the pleadings, proof of service, etc.

If you only have a Business & Finance attorney or secretary in class demo or have them
explore the business.dot.

If you have a mixture, tell students to look over the list of available templates and try out
any that might be important to them.
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SUMMARY

INSTRUCTOR NOTE:  This lesson should take approximately 3 minutes.  Be sure to
give the opportunity for Q&A.

You learned:

• How to set up initial information for MacPac

• The importance of Styles

• How to use MacPac to create and edit letters

• How to use MacPac to create and edit memos

• How to use MacPac to create and edit a fax cover sheet

• How to use MacPac automatic paragraph numbering


